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Metadados 

 
Informação Geral 
 
Título: À descoberta de objetos variáveis no céu 

Breve descrição: Esta atividade tem por objetivo proporcionar uma 
experiência de fotometria e de construção e análise de curvas de luz 
a partir de conjuntos de imagens de objetos de brilho variável, 
conduzindo o estudante a uma prática de projeto de investigação 
completa. 

Palavras-chave: curvas de luz, estrela variável, luminosidade; 
supernova, asteróides, exoplanetas; investigação de relatórios, 
fotometria 

 
Contexto educativo 
 
Contexto: É extremamente importante dotar os alunos de 
competências científicas na recolha e transformação de dados, bem 
como na transformação e análise de resultados a partir de uma 
representação gráfica. 

Faixa etária: 16 a 18 anos (Ensino secundário) 

 
Pré-requisitos: Conhecimentos de informática ao nível do utilizador 
para instalar e utilizar o software indicado. Conhecimentos de 
conceitos básicos de Física, Astronomia e Matemática são também 
desejáveis. 

Nível de dificuldade 4/5 

Duração: (15 horas no máximo consoante o conjunto escolhido). 
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Objetivo pedagógico 

Objetivos Cognitivos: Aprendizagem baseada em problemas para 
reforçar conceitos de física e de matemática. 
 
Afetivo: Promover o trabalho em grupo e a colaboração 
 
Psicomotor: Desenvolvimento das capacidades de observação e 
precisão e de destreza visual. 

 
Domínio 
 
As Grandes ideias da ciência: O Sistema Solar é uma parte muito 
pequena de uma galáxia entre milhões de galáxias do Universo. 

 
Disciplinas: Física, Astronomia, Matemática e TIC. 
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Orientar e fazer perguntas 
 

Olhar para o céu noturno dá-nos uma sensação de tranquilidade e imutabilidade 
que esconde a enorme variedade de fenómenos de diferentes objetos que não 
somos capazes de detetar apenas com os nossos olhos.  
 

 
 

Se alguns objetos celestes têm um brilho constante, outros podem apresentar 
variações de brilho cuja origem pode estar nas características ou comportamento 
do objeto, ou causada pela interposição de outros corpos que absorvem parte da 
sua luz. É a isto que chamamos objetos variáveis. Alguns exemplos de objetos 
variáveis: 

● Estrelas variáveis - estrelas que mudam o seu brilho aparente quando 
observadas a partir da Terra;  

 

● Supernovas - explosão estelar poderosa e luminosa que ocorre aquando 
da morte de uma estrela massiva, que emite abruptamente enormes 
quantidades de energia radiante.  

 
 

Questão: O que acontece à luz que é emitida por um objeto que está a explodir? 
Mantém-se brilhante ou desvanece-se com o tempo? 
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Exoplanetas - planetas fora do sistema solar que orbitam outras estrelas. 

Questão: o que acontece à quantidade de luz que recebemos da estrela quando o 
planeta passa à sua frente? 

● Asteróides – são pequenos objetos rochosos que orbitam em torno do Sol 
e que são demasiado pequenos para serem chamados de planetas. 
Normalmente, têm uma forma não esférica e rodam durante a sua órbita 
à volta do Sol.  

Questão: Por rodar e não ter uma forma regular, achas que vai refletir sempre a 
mesma quantidade de luz ou vai variar? 

 

Se respondeste que a luz recebida varia em todas estas situações, estás no 
caminho certo. Mas, se todas elas variam, temos de perceber como podemos 
diferenciar cada uma em relação às outras e, se possível, retirar ainda mais 
informação sobre o comportamento de cada um destes objetos. É aqui que vamos 
mostrar como se faz Ciência - medindo a luz e construindo Curvas de Luz. 
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Assim, uma curva de luz é apenas um gráfico que representa a variação do brilho 
de um objeto ao longo do tempo. Assim, a partir de um conjunto de várias 
imagens de uma região do céu, e utilizando o Salsa J, (ou outro software para o 
efeito), conseguimos fazer Fotometria e gerar curvas de luz que serão 
ferramentas extremamente importantes para desvendar os segredos do Universo 
e descobrir novos e exóticos objetos.  

Este é o desafio que esta atividade propõe, a partir de dados reais, colocando-te 
no papel de um cientista em busca dos segredos do Universo. 
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Criação e formulação de hipóteses 

Diferentes tipos de objetos fornecem diferentes curvas de luz 
 

Dependendo do fenómeno que cria a alteração da luz que emana do objeto, 
teremos diferentes tipos de curvas de luz. Assim, pela forma e duração do 
fenómeno, podemos classificá-lo e até interpretá-lo.  
 
Supernova - Quando uma estrela massiva chega ao fim da sua vida, pode causar 
uma explosão tão luminosa e poderosa que é capaz de ofuscar galáxias inteiras e 
libertar mais energia do que o Sol será capaz de emitir durante toda a sua vida. 
Estas explosões são conhecidas como supernovas e estão entre as mais poderosas 
do espaço. A curva de luz de uma Supernova (SN) depende muito do tipo de SN, 
mas será sempre rapidamente muito brilhante e depois desvanece-se 
lentamente. Assim, a curva de luz apresentará um rápido aumento de brilho que 
gradualmente se desvanece ao longo do tempo (geralmente 3-6 meses). 
 

 
 
 
Exoplanetas (Método de trânsito) - Os exoplanetas, por estarem muito longe de 
nós, são detetados indiretamente. Um dos métodos para a sua deteção é o 
método de trânsito. Quando um exoplaneta passa à frente da sua estrela, faz com 
que esta se desvaneça durante um curto período de tempo, antes de o planeta se 
afastar e a estrela voltar ao seu brilho normal. Assim, podemos consegui-lo 
também a partir de uma curva de luz. 
 

Fonte: https://pt.wikipedia.org/wiki/Supernova 
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Fonte: adaptado de https://www.planetary.org/space-images/transit-light-curves-for-keplers-first-five-exoplanets 

 
 

 
Uma estrela variável, por definição, é uma estrela cuja luminosidade varia numa 
escala de tempo inferior a 100 anos. Apresenta uma periodicidade regular no 
aumento e na diminuição da luminosidade. Esta regularidade manifesta-se 
graficamente nas curvas de luz que apresentam sinais periódicos (não 
necessariamente sinusóides). 

 
 

Fonte: https://www.seekpng.com/ima/u2t4e6t4i1y3r5e6/ 

https://www.planetary.org/space-images/transit-light-curves-for-keplers-first-five-exoplanets
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Asteróides - Os asteróides são corpos celestes que orbitam em torno do Sol e 
são demasiado pequenos para serem considerados planetas. Como normalmente 
têm uma forma irregular, quando rodam refletem a luz de uma forma variável, 
criando um padrão de brilho e desvanecimento, que se repete por períodos que 
vão de algumas horas a vários dias. Ao medir este brilho ao longo do tempo 
teremos curvas de luz que retratam esta oscilação de brilho em curtos períodos 
de tempo. 

 
 

 
 

 
 

  

Fonte: https://community.dur.ac.uk/physics.astrolab/a_lightcurve.html 
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Planeamento e Investigação 
Parte I – Atividade prática 
Como mencionámos anteriormente, os exoplanetas estão demasiado distantes e 
são demasiado pequenos para serem vistos diretamente, mesmo com os 
telescópios mais potentes. Então, como é que os astrónomos os podem detetar? 
Quando um exoplaneta passa em frente da sua estrela (a que chamamos 
trânsito), bloqueia parte da luz dessa estrela, diminuindo durante algum tempo 
o brilho que nos chega dela. Para que isso aconteça, o plano da órbita do 
exoplaneta tem de estar alinhado com a nossa perspetiva do planeta. 

Assim, ao medirem o brilho da estrela, este enfraquecimento ocasional da luz 
indica que um objeto se interpôs entre nós e a estrela, podendo deduzir-se que 
existe um forte candidato a exoplaneta em órbita da estrela. 

 

Fonte: https://spark.iop.org/sites/default/files/media/documents/the_transit_method__teacher%20notes.pdf 

Com esta atividade vais construir um modelo de exoplaneta, em órbita de uma 
estrela, para recolheres dados e investigares como é que podemos usar um 
trânsito para detetar exoplanetas. 

Montagem e materiais (por cada grupo de 2 a 4 
alunos) 

● Candeeiro (posição vertical)  

● Duas bolas diferentes de poliestireno 

● Espetos de churrasco e arame 

● Suporte de arame. 

● Computador com webcam e o software Light-
Grapher (https://spark.iop.org/interactive-
transit-method) 

 

 

https://spark.iop.org/interactive-transit-method
https://spark.iop.org/interactive-transit-method
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O que precisas de fazer: 

1. Usando a lâmpada como estrela, decide como representar o trânsito de 
um planeta em órbita à volta da estrela. Lembra-te que a bola suspensa 
deve poder rodar à volta da lâmpada, à altura desta. Montar o material de 
modo que o planeta circule em torno da estrela. 

2. Abrir a aplicação Light Grapher e apontar a câmara do computador para 
a estrela (lâmpada). Ativar a câmara do computador (ou web cam) e 
ajustar o tamanho do alvo de modo a circundar a estrela (lâmpada).  

 

3. Definir o tempo de 30 segundos para a amostragem no Light grapher  

4. Apontar a câmara do computador para a estrela, usar o gráfico de luz e 
colocar o planeta em órbita à volta da estrela para registar o trânsito. 

5. E se: Pensa sobre como a variação do tamanho e da velocidade do 
exoplaneta (testa com bolas diferentes e diferentes velocidades), ou 
alterações em outras variáveis que podem afetar a forma do gráfico. 
Idealiza a forma de proceder e regista o "E se" alterando uma variável de 
cada vez, indicando a tua previsão em cada caso esboçando a tua previsão 
de curva de luz esperada. 

6. Testa cada uma das alterações que idealizaste e regista a curva de luz 
produzida. Compara a que imaginaste com a que produziste. 
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.  
7. Compara os dados obtidos para as diferentes bolas, determina, para cada 

caso, o período de cada bola e justifica as diferenças observadas. 

8. Experimenta alterar área de captura da câmara, alargando-a a uma área 
maior do que a necessária, e repete a experiência. Qual é a tua conclusão?  

9. Regista todas as conclusões a que chegaste e discute os teus resultados 
com a turma (compara as tuas conclusões com as conclusões dos outros 
grupos). 

Nota: Se melhorares a montagem com uma mesa giratória (velocidade angular 
constante), podes tornar o exercício ainda mais interessante, uma vez que te vai 
permitir determinar outros parâmetros físicos do planeta e da sua órbita.  
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Parte II – Trabalhar com dados reais 
 

Como criar uma curva de luz (fotometria) utilizando o SalsaJ 
 

A fotometria é calculada através da correção dos valores integrados dos pixels, 
fornecidos pela intensidade luminosa do objeto, pelo valor do fundo do céu. Para 
o fazer, utilizamos o SalsaJ.  

As operações abaixo indicadas podem ser selecionadas através dos menus que 
serão indicados em cada caso, ou através dos ícones da barra de ferramentas aqui 
apresentados. 

 

1. Abre o teu ficheiro de imagem: File > Open. Depois de transferir e 
descomprimir os ficheiros de imagem, abre cada imagem (por ordem 
cronológica) ou seleciona um grupo de imagens (máx. 10) e utiliza o Windows 
> Tile para as distribuir no ecrã. 
 

2. Ajustar o brilho e o contraste da imagem. Normalmente, podes usar o botão 
"Auto" na janela Brightness & Contrast (Brilho e contraste). Com a 
distribuição de imagens em mosaico será mais fácil, basta selecionar cada uma 
delas e clicar em "auto". Se não for suficiente para mostrar toda a informação 
em estudo, ajusta a barra de máximo e mínimo de modo que as respetivas 
marcas demarquem os limites onde se encontra o sinal. Ajusta o brilho e o 
contraste para que todas tenham um fundo semelhante. Fazer o mesmo para 
todas e, se necessário, ajustar o brilho e o contraste para que todas as imagens 
fiquem idênticas.  

 
3. Seleciona Analyze > Photometry Settings (Configurações de fotometria). 
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 Podes escolher determinar automaticamente o centro e o raio da estrela 
selecionada e uma área de céu adequada, ou podes definir as coordenadas e o 
raio da estrela, e o valor do 
fundo do céu. 

As estrelas em imagens 
astronómicas têm um perfil 
específico quando representadas num gráfico de valores de pixels e esse perfil 
deve ser o mesmo para cada estrela na imagem. Para realizar corretamente a 
fotometria, é aconselhável estabelecer o valor mais adequado para o raio da 
estrela, de modo a obter resultados mais precisos. Para saber qual o melhor valor 
do raio da estrela, podes testar vários raios de abertura diferentes e comparar os 
valores de intensidade obtidos para cada raio, elaborando com uma folha de 
cálculo um gráfico do raio em função da intensidade. 

 
Quando o gráfico começa a aplanar, temos todas as estrelas na abertura correta. 
É uma boa escolha para trabalhar. 

4. Depois de definir os parâmetros de fotometria, vai a: Analyze > Photometry 
(ou o botão de fotometria). É apresentada uma nova janela "Photometry". Marca 
a mesma estrela em todas as imagens (basta clicar no centro da estrela). Será 
desenhado na imagem um círculo com o raio especificado no passo 3. Os valores 
medidos de intensidade e posição também aparecem na janela pop-up 
ʻPhotometryʼ. 
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Será desenhado um círculo na imagem, cujo raio estará de acordo com o definido 
no ponto 3. Na janela pop-up "Photometry", aparecem os valores medidos da 
intensidade e da posição.  

6. Outro dado que é importante recolher é a data e a hora, quer em formato atual 
quer em Data Juliana. Esta informação pode ser 
encontrada no Salsa J em Image - Show info e 
procurar MJD_OBS em / TIME AND EXPOSURE 
INFORMATION. 

 

 

7. Criar uma folha de cálculo para produzir a curva de luz. 
Podes criar a tua própria folha de cálculo ou utilizar a folha de cálculo proposta 
para esta atividade. Necessitamos da hora e do brilho da estrela em análise e das 
estrelas de referência. 
Copiando e colando os dados de cada estrela da janela Fotometria do SalsaJ 
para uma folha de cálculo Excel, e a hora (Data Juliana JD) recolhida como vimos 
anteriormente, podemos estruturar esta folha de cálculo de forma a criar as 
curvas de luz. 
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Como a escala é diferente entre os três gráficos, temos de normalizar os dados. 
Para o fazer, calculamos a média das medições e subtraímos cada valor ao valor 
médio.  

Traçar a dispersão dos dados normalizados das três estrelas ao longo do tempo, 
no mesmo gráfico, seria suficiente para compreender a variabilidade do brilho 
das estrelas. 

Também podemos escolher no gráfico qual é a melhor estrela (a que mantém o 
brilho praticamente constante) para ser usada como estrelas de referência. O 
brilho da estrela de referência em cada imagem manifesta, da mesma forma, os 
efeitos de vários fatores que podem afetar os valores medidos. Para anular esses 
efeitos, basta estabelecer o quociente entre o brilho da estrela em estudo e o da 
estrela de referência (o valor mais pequeno no numerador). 

Para ilustrar o que foi dito, neste caso começamos por comparar o brilho das 
estrelas em conjunto, usando as suas médias como referência, o que nos permite 
perceber que a estrela 2 sofre uma queda acentuada de brilho (gráfico 1). De 
seguida, isolámos apenas esta (que varia). Tentámos ainda usar a abordagem de 
comparar a estrela 2 com as estrelas 1 e 3 usadas como referência. 
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● Comparar as curvas. Que estrela deve ser estudada e qual deve ser a estrela 
de referência? 

● Qual foi a duração da diminuição do brilho da estrela? 
● O que é que pode ter causado este decréscimo de brilho da estrela? 

 

 Está na hora de criares e analisares as tuas próprias curvas de luz. Vamos a isso! 

 

Nota: O "formato de data juliana" refere-se a um formato em que o valor do ano 
de uma data é combinado com o "dia ordinal desse ano" (ou seja, 14º dia, 100º dia, 
etc.) de modo a formar um carimbo de data. No Excel, podes converter uma data 
na célula B5 para JD com a seguinte fórmula =YEAR(B5, "yyyy")&TEXT(B5-
DATE(YEAR(B5),1,0), "000) 

 

Fontes: 

https://www.cosmos.esa.int/web/hipparcos/examples-part-a  

https://www.cosmos.esa.int/web/hipparcos/examples-part-b 

https://www.aavso.org/about-light-curves  

https://www.aavso.org/variable-star-astronomy  

https://www.aavso.org/sites/default/files/education/vsa/Chapter11.pdf  

https://sites.google.com/view/faulkestelescopeproject/resources/photometry-
with-salsaj?authuser=0 

 

  

https://www.cosmos.esa.int/web/hipparcos/examples-part-a
https://www.cosmos.esa.int/web/hipparcos/examples-part-b
https://www.aavso.org/about-light-curves
https://www.aavso.org/variable-star-astronomy
https://www.aavso.org/sites/default/files/education/vsa/Chapter11.pdf
https://sites.google.com/view/faulkestelescopeproject/resources/photometry-with-salsaj?authuser=0
https://sites.google.com/view/faulkestelescopeproject/resources/photometry-with-salsaj?authuser=0
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 Parte III – Do it yourself 
 
Agora que já sabes alguns conceitos básicos sobre objetos 
variáveis e como fazer e interpretar as curvas de luz, está 
na hora de arregaçar as mangas e começar a trabalhar com 
dados reais, lançando hipóteses, fazendo curvas de luz e 
interpretando os resultados. É hora de te colocares na pele 
de um cientista. 

Sugerimos que os alunos sejam distribuídos por grupos de trabalho e que a cada 
grupo seja distribuído um conjunto de imagens para investigar o tipo de objeto 
variável. 

Realizar a investigação 

o Primeiro, é necessário fazer o download e instalar o SalsaJ 
(http://www.euhou.net/index.php/salsaj-software-mainmenu-9)  

o Distribuir os conjuntos A, B e C pelos grupos de trabalho. 

● Conjunto A; 

 

● Conjunto B; 

 

● Conjunto C 

 

●  
●  

●  

● Usar as 3 estrelas 
mais brilhantes 
para produzir a 
curva de luz 

● Escolha a cefeida 43522 
para traçar a curva de luz 

● Escolha a estrela 
marcada com o ? para 
traçar a curva de luz 

 

o Seguir o procedimento acima descrito e utilizar a folha de cálculo criada para 
esta atividade, escolher o separador correspondente ao respetivo conjunto. 
Podes utilizar a folha de cálculo fornecida ou criar a tua própria folha de cálculo. 

o O brilho é sempre representado no eixo vertical (y). O tempo, normalmente 
utilizado na unidade Dia Juliano, mas para uma melhor interpretação, podes 

http://www.euhou.net/docupload/files/Exercises/Exoplanet_transit/20image_spitzer.zip
http://www.euhou.net/docupload/files/Exercises/Exoplanet_transit/20image_spitzer.zip
http://www.euhou.net/docupload/files/Exercises/Cepheids/cepheids.zip
http://www.euhou.net/docupload/files/Exercises/Cepheids/cepheids.zip
https://dev.schoolsobservatory.org/sites/default/files/discover/supernovaeproject/Gaia16agf-data.zip
https://dev.schoolsobservatory.org/sites/default/files/discover/supernovaeproject/Gaia16agf-data.zip
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utilizar o formato convencional de data e hora, sempre representado ao longo 
do eixo horizontal (x). 

o Traçar uma curva suave "que melhor se ajuste" através dos pontos dos dados. A 
tendência geral dos pontos vai dar-nos a informação que queremos sobre o 
comportamento da estrela (não os pontos individuais). 

o Se necessário, reformular os parâmetros ou as estrelas de referência de modo a 
clarificar o tipo de objeto em análise. 

 

Análise & Interpretação 
 

Identificar no gráfico quando é que a estrela em análise é mais e menos 
brilhante. 

● Uma variação completa na emissão de luz de uma estrela variável, de 
máximo a máximo (pontos mais brilhantes) ou de mínimo a mínimo 
(pontos menos brilhantes), é designada por ciclo. A tua estrela já passou 
por um ou mais ciclos? Qual é a duração do ciclo (a que chamamos 
período)? 

● Identificar que tipo de objeto variável pertence ao teu conjunto de 
imagens. 

 

Conclusão & Avaliação 
 

 

Agora que já encontraste as respostas para o problema, faz uma pesquisa que te 
ajude a compreender melhor este tipo de objeto celeste e, com base nisso e nos 
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resultados da curva de luz que produziste, faz uma caraterização mais detalhada 
do mesmo. 

Elaborar um trabalho escrito/apresentação sobre o teu objeto de análise, para o 
apresentares à turma com os teus resultados. 

Compara o teu resultado com os dos teus colegas. Porque é que eles obtiveram 
resultados diferentes? Uma vez que tinham os mesmos dados e seguiram as 
mesmas instruções, não deveriam ter o mesmo resultado? 

Se utilizaste os mesmos dados de outro grupo e chegaste a resultados diferentes 
(mesmo que tenhas chegado às mesmas conclusões), discute essas diferenças e 
as razões que estão na sua origem. 

Qual foi a parte mais interessante desta atividade e o que consideraste menos 
interessante? Assinala os conceitos que tiveste de utilizar para a resolução desta 
atividade. 

Relativamente à importância para ti deste pequeno projeto, classifica cada 
tópico de 1 - muito mau a 5 - muito bom: 

● O interesse que esta atividade representou para ti. 

● Os conhecimentos adquiridos/reforçados 

● As competências trabalhadas 


